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Preface

This guide provides instructions on how to install the PeerDirect Distributed Enterprise SDK. 
It walks you step-by-step through each install phase and gives you information about what to 
do next. 

Before you install, be sure to read the PeerDirect Distributed Enterprise SDK Release Notes. 
Release Notes provide important information about version 6.1 and describe the final software 
requirements, enhancements, and known limitations. Release Notes are located in the top-level 
directory of your installation CD-ROM.

After you install the software, you are required to perform additional steps to prepare your 
database for activation and replication. This information is described in the Chapter 4, “Setting 
Up PeerDirect Replication” and in the PeerDirect Replication Engine Tutorial.

The Tutorial does not cover deployment or advanced features, such as fragments and work sets. 
For more information about these topics, please see the PeerDirect Replication Engine (PDRE) 
Developer’s Guide and Reference. Both the Tutorial and the Developer’s Guide are available 
from your desktop Start menu (Start > Program Files > PeerDirect > Documentation). 

Who’s This Guide For

This guide is intended for any persons who are responsible for setting up and maintaining a 
PeerDirect replication network. This person may also be responsible for administering the 
network’s software components, including PeerDirect replication servers and adapters, 
databases, and ODBC drivers. In this guide this role is referred to as the PeerDirect 
administrator.

A PeerDirect administrator should already be a certified database administrator for the 
databases they are replicating. The PeerDirect documentation is specific to PeerDirect products 
and offers only guidelines for integrating third-party vendor and Open Source databases as part 
of a PeerDirect replication network.
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What’s In This Guide

This guide contains the following chapters:

• Chapter 1, “Welcome to PeerDirect Distributed Enterprise SDK” — provides a general 
introduction to the installation process and describes options for configuring your 
replication network.

• Chapter 2, “Installing the PeerDirect Distributed Enterprise SDK” — describes the steps 
for installing the PeerDirect Distributed Enterprise SDK on the Red Hat Linux and 
Microsoft Windows platforms.

• Chapter 3, “Building a PeerDirect Deployment Kit” — describes steps for embedding 
application files and scripts in a PeerDirect Install Program for easy installation and setup.

• Chapter 4, “Setting Up PeerDirect Replication” — describes how to set up a PeerDirect 
Replication Network in a test or development environment using the PeerDirect SDK 
software.

Notation Conventions

This guide uses the following notation conventions.

• The notation Menu > Choice indicates that you should choose an item from a menu. For 
example, the notation File > Exit means: “Open the File menu and choose Exit.”

• Italics indicate the title of a book or emphasizes the first usage of a term that will be 
referred to repeatedly in the guide.

• Monospace text indicates commands, functions, code examples, and names of files 
and directories. For example:

C:\Program Files\PeerDirect\setup.exe

• Monospace italic text indicates that a term can be replaced by a literal value. 
Typically the term is enclosed in arrow brackets (< >) and used in example text, such as 
command lines or directory paths. The user is expected to replace the term with an 
appropriate value. For example:

<drive>:\<install_dir>\setup.exe

where <drive> can be replaced by the drive name "C" and <install_dir> can 
be replaced by the installation directory name "Program Files\PeerDirect".
ii



How to View This Guide Online

Online versions of this guide are available in Adobe™ Acrobat™ (PDF) and HTML format on 
the PeerDirect Distributed Enterprise SDK CD-ROM. All PeerDirect product documentation is 
located in the peerdirect\pdre\docs directory.

Customer Support

If you encounter a technical problem and are covered by a PeerDirect Customer Support 
agreement, please email our support team at support@peerdirect.com.

The PeerDirect Customer Support team is dedicated to providing rapid, high quality response 
to customer problems. When contacting Customer Support, please provide the following 
information:

• Case number (if you are calling about a previous problem)

• Your name

• Your company name and location (city, state or province, and country)

• Contact information

• Product name and version

• Operating system

• Database type

• Detailed problem description that includes specific symptoms, observations and any 
troubleshooting steps you might have tried.

Please attach PDRE activity log file(s) when possible.
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1
Welcome to PeerDirect Distributed 
Enterprise SDK

This chapter introduces you to the PeerDirect Distributed Enterprise SDK and consists of the 
following chapters:

• Overview

• Product Licenses

• About the Install Program

• What’s Next
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1.1 Overview 
The PeerDirect Distributed Enterprise SDK provides a development environment for building 
and testing a PeerDirect Replication Network. The PeerDirect SDK software installs everything 
you need to install an InnerEdge or OuterEdge Server or Workstation. 

The PeerDirect Replication Network is a configuration of InnerEdge and OuterEdge Servers. 
Typically, a replication network consists of an InnerEdge Server located at your central data 
center and several OuterEdge Servers set up in remote offices or at field sites. An application 
runs locally using data stored in local databases and therefore, is always available. In the 
background, the PeerDirect Replication Engine (PDRE) manages changes to your application 
by replicating and synchronizing data updates with other applications you’ve designated as 
active sites in the network. 

The following figure shows a replication network that consists of two InnerEdge Servers (home 
office) connected over a TCP/IP network to several OuterEdge Servers set up in remote field or 
office locations.

Figure 1–1: PeerDirect Replication Network
2
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You can set up a PeerDirect Replication Network in several different ways, but for greatest 
benefit, we recommend you select one that matches the business requirements for distributing 
application data within your system. Each PeerDirect network manages the database for one or 
more applications (or unrelated database tables) that you wish to connect across your 
organization. There’s no limit to the number of replication networks you can set up. 

For more information about replication network layout options, please refer to the PeerDirect 
Replication Engine Tutorial. This tutorial is available on your installation CD-ROM in the docs 
directory.

For assistance in planning your PeerDirect replication network, please contact your PeerDirect 
account manager or send email to PeerDirect customer support at support@peerdirect.com.

1.1.1 Installing a Replication Network
A PeerDirect Replication Network consists of at least two sites: one must be an InnerEdge 
Server, while the second may be either another InnerEdge Server or an OuterEdge Server or 
Workstation. Here are a few rules and recommendations to consider when setting up a 
PeerDirect Replication Network.

1: Always install an InnerEdge Server first, before you install the OuterEdge Servers.

The InnerEdge Server contains a highly-available complete database. To create a PeerDirect 
Replication Network, install the InnerEdge Server first and then install the additional InnerEdge 
or OuterEdge Servers for the same network. 

The first InnerEdge Server performs the one-time initializations that are critical for each 
PeerDirect Replication Network and that enable the first InnerEdge Server to validate and 
accept subsequent sites into the same network.

2: Consider the availability properties of planned replication sites. Install InnerEdge 
Servers at high-availability sites and OuterEdge Servers at low-availability sites.

You would install an OuterEdge Server or Workstation on a remote site that you do not expect 
to be continually connected to the central home database. The OuterEdge Server or Workstation 
is typically configured for low-availability, which means that other sites on the network would 
attempt to connect and replicate with the high-availability InnerEdge Server. 

The OuterEdge Server or Workstation is typically configured for low-availability. When you 
install an OuterEdge Server, the deployed site is not automatically configured. You must 
specify the site type as LOW during the activation of the site by using the -sitetype parameter 
on the dinst utility. See Chapter 4, “To prepare to activate the database on the OuterEdge 
Server.”

In general, we recommend you install the OuterEdge Workstations on laptops or single-user 
systems and install OuterEdge Servers on multi-user systems.
3
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3: Installation is only one of several steps. 

After you’ve installed your PeerDirect software, there are several tasks you must perform in 
order to set up a PeerDirect Replication Network. These include

Creating Replication Rules — you open the PeerDirect Replication Designer (PRD), 
available as part of the PeerDirect SDK product, and create replication rules that you 
export to a file. 

Activating Replication Sites — next you activate an InnerEdge Server, also known as the 
"first site". You then activate the remaining sites on either an InnerEdge Server or an 
OuterEdge Server or Workstation. During the activation phase, each site contacts the "first 
site" and starts its first replication cycle. 

For detailed information about setting up replication, see chapter Chapter 4, “Setting Up 
PeerDirect Replication.” Also refer to the PeerDirect Replication Engine Tutorial. This tutorial 
is installed in the peerdirect\pdre\docs directory.

1.1.2 Supported Databases
For information regarding each database supported by PeerDirect, please refer to the on-line 
reference guide available in the docs directory on your installation CD-ROM. For information 
about specific vendor databases, please refer to the vendor’s documentation.

PeerDirect SDK version 6.1 supports the following databases:

• IBM DB2 Universal Database 6.1, 7.1, and 7.2

• IBM Informix 7.3 (Windows platforms only)

• Borland InterBase 5.6 and 6.0

• Microsoft SQL Server 7.0 SP2 and 2000

• Oracle 8.0.6, 8.1.5, 8.1.6, 8.1.7, and Oracle 9i

• Progress RDBMS 9.1D

• PostgreSQL 7.2

• Sybase Adaptive Server Anywhere 7

• Sybase Adaptive Server Enterprise 11.x using 11.1.1 EBF 7729 client

• Sybase SQLAnywhere 5.5.05

NOTE: There is no available Linux ODBC driver for Informix 7.3.
4
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1.1.3 Supported ODBC Drivers and Replication Adapters
The following ODBC drivers and replication adapters have been certified for use with the SDK. 
Please contact PeerDirect at support@peerdirect.com if you have questions. A list of 
unsupported drivers is provided in the Release Notes.

** For Linux, please edit the location of the Progress ODBC driver file (pgpro915.so) if it 
differs from the default one. The file to edit is pdodbc located in the installation directory.

Database Supported Drivers and Adapters

IBM DB2 UDB 6.1 IBM DB2 ODBC DRIVER Version 6.01.00.00

 IBM DB2 UDB 7.1 IBM DB2 ODBC DRIVER Version 7.01.00.00

IBM DB2 UDB 7.2 IBM DB2 ODBC DRIVER Version 7.02.00.00

 IBM Informix 7.3.1 Peer Direct INFORMIX

 Borland InterBase InterBase InterSolv Driver (*.gdb) Version 
3.11.01.00

Microsoft SQL Server 7.0 SP2  SQL Server Version 3.70.08.20

Microsoft SQL Server 2000 Peer Direct SQL Server

Oracle 8.0, 8i and 9i Peer Direct Oracle, Peer Direct Oracle8

Progress RDBMS 9.1D MERANT 3.60 32-BIT Progress SQL92 v9.1D, 
DataDirect 4.10 Progress9 **

PostgreSQL Peer Direct PostgreSQL

Sybase Adaptive Server 
Anywhere 7

PeerDirect Sybase

Sybase Adaptive Server 
Enterprise 11.x

PeerDirect Sybase

Sybase SQLAnywhere 5.5.05 Sybase SQLAnywhere 5.0 Version 5.05.011333
5



PeerDirect Distributed Enterprise SDK Installation Guide
1.2 Product Licenses
There are two types of PeerDirect license files — PeerDirect Network License (PNL) and 
PeerDirect Developer License (PDL). 

The PeerDirect Network License (PNL) allows you to activate a vendor-specific database and 
replicate data with other databases in a PeerDirect Replication Network. You must obtain 
database software separately and install it according to vendor instructions before you install 
your PeerDirect product.

The PeerDirect Developer License (PDL) lets you enable any database type for replication, but 
it does not let you deploy a replication network. The Developer License lets you define rules for 
a database, as for example a Progress database, but you would then need a Progress Replication 
Network License before you could activate the sites and deploy the replication network.

PeerDirect product licenses are distributed by PeerDirect Technical Support. If you need 
assistance, please contact them at support@peerdirect.com.

The following table lists PeerDirect products and the data management products they support: 

Table 1–1: PeerDirect SDK Products and Related Databases

PeerDirect Products Related Database Product

PeerDirect Distributed Enterprise SDK 
for the InterBase Database

Borland InterBase 5.6 and 6.0

PeerDirect Distributed Enterprise SDK 
for the DB2 Database

IBM DB2 Universal Database 6.1, 7.1, 
and 7.2

PeerDirect Distributed Enterprise SDK 
for the Informix Database

IBM Informix Dynamic Server (IDS) 7.3

(only available on Windows platforms)

PeerDirect Distributed Enterprise SDK 
for the SQL Server Database

Microsoft SQL Server 7.0 SP2 and 2000

PeerDirect Distributed Enterprise SDK 
for the PostgreSQL Database

PostgreSQL7.2

PeerDirect Distributed Enterprise SDK 
for the Oracle Database

Oracle 8.0.6

Oracle 8i (8.15, 8.16, and 8.17)

Oracle 9i

PeerDirect Distributed Enterprise SDK 
for the Progress Database

Progress RDBMS 9.1D
6
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1.3 About the Install Program
The PeerDirect Distributed Enterprise SDK install program uses the PeerDirect install program, 
a Web-based installation program with a built-in "create your own" custom application installer 
tool. 

When you install the PeerDirect SDK, you can choose to 1) install all components, 2) select any 
subset of components, or 3) create an install kit of custom-selected components (see 
“Installation Options”). This last feature, called "Create Deployment Kit", gives you the ability 
to embed your applications within a PeerDirect install program for easy deployment to 
replication sites. 

The PeerDirect SDK components include everything you need to set up a software development 
environment for developing a replication system for critical business applications. The SDK 
components are listed in “Installation Components” below. The PeerDirect install program 
installs the appropriate components into an installation directory that you specify, and creates 
shortcuts on your desktop for easy access. 

For instructions about how to install the PeerDirect Distributed Enterprise SDK, see Chapter 2, 
“Installing the PeerDirect Distributed Enterprise SDK.”

1.3.1 Installation Components
PeerDirect is a software system for replicating and synchronizing data stored in databases. It 
supports asynchronous, bidirectional database replication across TCP/IP networks, including 
the Internet, and replicates structured data between both homogeneous and heterogeneous 
database types. 

NOTE: PDA is available for the Windows platform only. If you are installing on Linux, 
you’ll need to install the PeerDirect InnerEdge Server or OuterEdge Server Client 
Access edition on a Windows machine and use the dinstc utility to establish the 
connection from the Windows machine to the PDRE running on the Linux machine. 

PeerDirect Distributed Enterprise SDK 
for the Sybase ASA Database

Sybase Adaptive Server Anywhere 7

Sybase SQLAnywhere 5.5.05 

(only available on Windows platforms)

PeerDirect Distributed Enterprise SDK 
for the Sybase ASE Database

Sybase Adaptive Server Enterprise 11.x

Table 1–1: PeerDirect SDK Products and Related Databases

PeerDirect Products Related Database Product
7
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This allows the PeerDirect Administrator console to connect to PDRE on a Linux 
machine and administer the specified database in the network. The dinstc utility is 
available for both Linux and Windows platforms.

Each SDK installs the following PeerDirect software components:

Component Description

PeerDirect Replication 
Engine (PDRE)

(optional) core replication component. PDRE 
detects changes made to application databases 
since the last replication session and 
propagates these changes to other 
replication-enabled sites on a network. It 
performs all replication tasks including 
database updates, inserts, and deletions.

PeerDirect Replication 
Designer (PRD)

(Windows only; not 
installed on Linux)

(optional) GUI interface for defining 
replication sites and rules; installs on 
Windows platforms only. Select the Client 
Access Edition to install this component.

PeerDirect Replication 
Engine Administrator 
(PDA), also called PDRE 
Admin

(Windows only; not 
installed on Linux)

(optional) administers replication scheduler 
and subscribes work set slices; installs on 
Windows platforms only.

PDRE "Replicate Now" 
Add-on

application-embedded task dialog box that 
lets end users initiate data replication by 
clicking a single button.

Database ODBC Drivers 
and Replication Adapters

installs all PeerDirect ODBC drivers and 
replication adapters for all database types.

PeerDirect 
Documentation

(optional) installs these technical documents:

• PeerDirect Tutorial Guide

• PeerDirect Developer’s Guide and 
Reference (not available on Linux)
8
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1.3.2 Installation Options
The PeerDirect SDK installation program gives you three installation options:

• Quick Installation — installs all components and their default settings to an installation 
directory that you specify. On Linux, you also specify a user name that will own the PDRE 
daemon.

• Custom Installation — installs only those components you select. For certain 
components, you may also select server ports, server start-up preferences, and other 
settings.

• Create Deployment Kit — installs or creates an installation deployment kit based on the 
components you select. You can also add new components, such as application files, and 
specify scripts to run as part of the installation process. For more information about using 
the "Create Deployment Kit" option, see Chapter 3, “About the Create Deployment Kit 
Option.”

1.4 What’s Next
For information about how to install the SDK, see Chapter 2, “Installing the PeerDirect 
Distributed Enterprise SDK.” For more information about setting up your replication network, 
refer to the PeerDirect Replication Engine Tutorial Guide and to Chapter 4, “Setting Up 
PeerDirect Replication” in this guide. 
9
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2
Installing the PeerDirect Distributed 
Enterprise SDK

This chapter describes how to install the PeerDirect Distributed Enterprise Software 
Development Kit (SDK). It includes the following sections:

• Planning Your Install

• Before You Install

• System Requirements

• Installing the PeerDirect Distributed Enterprise SDK

• Performing a Remote Installation of the SDK

• Updating an SDK Installation

• Uninstalling the SDK

• What’s Next
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2.1 Planning Your Install
Deploying a PeerDirect Replication Network requires that you perform multiple installations of 
InnerEdge and OuterEdge Servers that run the PeerDirect Replication Engine. This is required 
whether you are installing a two-server failover system, a development or test environment, or 
a large network of application servers. 

Because a PeerDirect Replication Network is made up of individual replication nodes that have 
different requirements based on their position in the network (see Chapter 1, “Installing a 
Replication Network”), the first step to planning your installation is to identify the replication 
requirements for the machine you are installing. If you are uncertain about which PeerDirect 
replication product you need to install, please consult with your PeerDirect account manager.

The installation instructions in this guide describe how to install the PeerDirect software 
development kit (SDK) on a development or test server. For information about planning your 
replication network layout, please refer to the PeerDirect Replication Engine Tutorial.

2.2 Before You Install
Before you begin, PeerDirect recommends you do the following:

1. Verify that you’ve received the correct PeerDirect software license from PeerDirect 
Technical Support. The PeerDirect software development kit (SDK) license allows you to 
install InnerEdge and OuterEdge servers or workstations, connected to any 
PeerDirect-supported database, for purposes of software development and testing.

2. Review the system requirements in “System Requirements” below and verify that the 
machine you plan to install PeerDirect software on meets these requirements.

3. Read the Release Notes for the PeerDirect SDK for any last-minute information that may 
be important to you. You’ll find release notes located in the top-level directory of the 
PeerDirect SDK installation CD-ROM.

4. Verify that your system hardware and software meet the requirements for the type of 
PeerDirect Replication Network you have planned. You’ll find the requirements for 
PeerDirect replication servers and workstations in the PeerDirect Release Notes.

5. If you are planning to replicate an existing database, we strongly recommend you back up 
your database before you begin the SDK installation process.

6. On Linux, if you want more than one person to be able to run the PDRE daemon, specify 
a user name or account to own it and place that user in a group to which you can add other 
users.
12
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7. On Linux, you must install as root user. On Windows, you must have administrator 
privileges to install

You install the PeerDirect SDK from the PeerDirect Distributed Enterprise SDK CD-ROM (see 
“To start the install program” below). If you have any questions about your PeerDirect software 
or license, please contact Technical Support at support@peerdirect.com.

2.3 System Requirements
The PeerDirect Distributed Enterprise SDK version 6.1 runs on the following system platforms:

** Minimum physical memory should be at least two times the size of the largest individual 
record to be replicated. For example, if your database has a single record containing 50 MB of 
data, then a minimum of 100 MB RAM memory is required to avoid performance degradation.

Operating 
Systems Version Requirements

Red Hat® Linux Red Hat 7.2 Hardware: Pentium-based 
(or higher) computer running 
Red Hat Linux. 

Memory: Minimum of 64 
MB; recommend 128 MB.**

Disk Space: Minimum of 100 
MB hard disk space.

Microsoft® 
Windows

• Windows 2000

• Windows NT Server 
(v4.0 with Service Pack 6 
or higher)

• Windows NT 
Workstation (v4.0 with 
Service Pack 6 or higher)

Hardware: Pentium-based (or 
higher) computer running any 
Windows NT-based (Win32) 
operating system. 

Memory: Minimum of 64 
MB; recommend 128 MB.**

Disk Space: Minimum of 100 
MB hard disk space.
13
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2.4 Installing the PeerDirect Distributed Enterprise SDK
This section describes how to install the PeerDirect SDK version 6.1.

2.4.1 PeerDirect Installation Options
The PeerDirect installation program gives you three ways to install PeerDirect software.

Quick Installation

Select the Quick Installation method for an easy installation of all components in the installation 
kit. This option lets you select the installation directory and configures the installation using 
default settings. 

On Linux, the Quick Installation program asks for the name of a user who will own the PDRE 
daemon after the installation. If you select Quick Installation, they will all run under one user. 

NOTES: If you want the daemons to run under separate users, select the Custom Installation 
method and specify user names for each component.

Custom Installation

The Custom Installation method lets you select which software components to install. Select 
this option if you want to change default settings or select only a subset of components for 
installation. This option allows you to iteratively change the configuration of your installed 
components and to remove components you no longer want installed without uninstalling your 
entire PeerDirect installation.

Create Deployment Kit

The Create Deployment Kit option lets you select PeerDirect software and other application 
components to install to a kit installation area. You must first create the installation area for the 
kit before you create the actual deployment kit. After you create the kit, you can copy it to a 
CD-ROM and distribute it, or you can place it on your Web site for downloading by end users. 

The Create Deployment Kit option is intended for developers who wish to build a customized 
PeerDirect installation for distributing applications. The installation kit can be built to include 
PDRE so that when it is deployed, it installs all components required to set up a PeerDirect 
Replication Network. 

To install and create a deployment kit, please read the instructions in Chapter 3, “Building a 
PeerDirect Deployment Kit.”
14
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2.4.2 SDK Installation Steps
Follow these instructions if you are installing the PeerDirect SDK for the first time. If you are 
performing a follow-up installation or update to your current installation, see “Updating an SDK 
Installation” below.

To start the install program

1 ♦ Follow instructions below for your platform:

• Linux — Log on as a root user. Load and mount the SDK installation CD-ROM.

NOTE: The install program should start. If the install program does not start, open 
the CD-ROM directory and run ./setup. 

• Windows — Log on to a Windows server or client machine. Insert the SDK 
installation CD into your CD-ROM drive.

NOTE: The install program should start automatically. If your Windows auto-run 
setting is turned off, choose Start > Run, browse to the CD-ROM drive, 
select the setup.exe file, and click OK. To start the install program from 
a command-line prompt, change to your installation directory and type 
setup.exe -browser=ie.
15
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2 ♦ The Welcome to PeerDirect Software Installation screen displays. Click START 
INSTALLATION.
16
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3 ♦ In the Specify the installation location field, enter the full directory path for the 
installation directory. The install program will install the PeerDirect SDK software in this 
directory. Accept the default, type a new path, or click Browse to specify an existing 
directory on your system. The default installation directory paths are on Linux 
/usr/local/peerdirect, and on Windows C:\Program Files\PeerDirect. 

4 ♦ Click Continue.
17
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5 ♦ Read the PeerDirect license agreement carefully.

• If you agree to the license, scroll to the bottom of the page and click ACCEPT to 
launch the install program. Proceed to Step 4.

• If you do not agree to the license, scroll to the bottom of the page and click 
DECLINE to exit.
18
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6 ♦ Select one of the following installation methods:

• Quick Installation — installs all PDRE components using the Runtime edition 
default settings.

• Custom Installation — lets you select which components you want to install and 
allows you to change component settings.

• Create Deployment Kit — installs and creates an installation deployment kit based 
on the components you select.
19
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7 ♦ If you selected Quick Installation, click Continue.

8 ♦ Verify the components that will be installed. and do the following:

a) In the Specify the PDRE Development File location field, enter the full directory 
path where the PeerDirect Developer License (PDL) file is stored on your system. 
This file is e-mailed to you by PeerDirect Technical Support when you purchase your 
software.You can type the path or click Browse to find the file.

b) On Linux, in the Specify the component account field, enter a user name. The user 
name or account you specify will be able to run all daemons for installed components 
after the installation completes. Check Create New User if you want the user name 
or account created and added to your system. 

c) Click Install and go to Step 13.
20
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9 ♦ If you selected Custom Installation, click Continue.

10 ♦ The Configure the following Components screen displays. 

a) Review the list of PeerDirect components available. Specify which components you 
want installed by checking Install (default) below each component name. If you do 
not want a component installed, uncheck the Install checkbox.

NOTE: If you have previously installed components, the install program recognizes the 
previous installations and gives you the option to update them. See “To update 
an SDK installation” in this chapter.

b) Check (default) Install Documentation to install the PeerDirect Replication Engine 
Tutorial (available on Windows and Linux) and the online PDRE Developer’s Guide 
and Reference (available on Windows only) in the peerdirect\pdre\docs 
directory on your system. You can then access PDRE documentation from the Start 
menu on your desktop (Start > Programs > PeerDirect > Documentation).
21
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c) Check (default) PDRE Designer if you want to install this component. The 
PeerDirect Replication Designer (PRD) is needed to create a rules (RUL) file and to 
define other configuration settings in preparation for deploying a PeerDirect 
Replication Network.

d) In the Development License File field, enter the full directory path where the 
Developer License (PDL) file is stored on your system. This file is e-mailed to you 
by PeerDirect Technical Support when you purchase your software.You can type the 
path or click Browse to find the file.

e) On Linux, in the Specify the component account field, enter a user name. This user 
name will be able to tun the PeerDirect Replication Engine daemon. If the name you 
specify does not exist, check Create New User to automatically create and add it to 
your system.

NOTE: On Linux, the user name is the individual who will be responsible for the 
PeerDirect Replication Engine (PDRE) daemon. If you want multiple 
persons to be able to run the PDRE component daemon, specify a user name 
to own it and attach the user to a group. You can then attach other users who 
need to run the daemon to the same group.

NOTE: On Windows, PDRE is installed as a Windows Service by default.

11 ♦ After you select your components, click Install. Go to Step 13.

12 ♦ If you selected Create Deployment Kit, see instructions in Chapter 3, “Building a 
PeerDirect Deployment Kit.”
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13 ♦ The install program lists each component as it installs and shows you the progress of the 
installation. 

14 ♦ When the installation completes, close your browser window.
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2.5 Performing a Remote Installation of the SDK
You can install the PeerDirect SDK from a remote machine by logging onto the computer where 
you want to install the SDK, starting the setup script, and controlling the remote installation 
process from a local browser. The PeerDirect install program lets you run an installation from 
a Web browser on any Linux, Solaris, Windows, or MacIntosh system.

To perform a remote install to a Linux system

1 ♦ Mount the PeerDirect SDK installation CD-ROM on the target server where you want to 
install the SDK software.

2 ♦ Open a command-line shell (for example, telnet, rlogin, ssh2, characters console) on the 
machine from which you want to perform the installation.

3 ♦ Log on as a root user.

4 ♦ Change to the /mnt/cdrom directory on the target server and launch the ./setup script.

5 ♦ You are prompted to open a browser with the following URL:

http://<target_machine>:4001

NOTE: If port 4001 is in use on the target machine, use a different port.

6 ♦ Follow instructions for installing the PeerDirect SDK in “Installing the PeerDirect 
Distributed Enterprise SDK,” 

7 ♦ When the install program completes, press Ctrl/C to exit the setup script.
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2.6 Updating an SDK Installation
With the ability to embed multiple components into a PeerDirect install program, you may find 
the need to update your PeerDirect SDK installation. The update process is flexible and lets you 
choose which components you want to update, remove or ignore. To update your SDK 
installation, run the version 6.1 install program and specify the location of your existing SDK 
install directory. The SDK install program recognizes the PeerDirect components you have 
installed and will upgrade your server using the new components you select.

There are three options for each installable component: 

• Update — (default) reinstalls a current version or a new version.

• Remove — deletes the software component from the installation area.

• Ignore — does not install or upgrade the software component.

NOTE: When upgrading from PeerDirect version 6.0 to 6.1, the install program removes the 
6.0 installation in C:\Program Files\PeerDirect and installs version 6.1.

The SDK install program will update only those components where you select the "Update" 
radio button. 

Please be sure to read the Release Notes before you perform an upgrade.

To update an SDK installation

1 ♦ Follow instructions below for your platform:

• Linux — Log on as a root user. Load and mount the SDK installation CD-ROM.

NOTE: The install program should start. If the install program does not start, open 
the CD-ROM directory and run ./setup. 

• Windows — Log on to a Windows server or client machine. Insert the SDK 
installation CD into your CD-ROM drive.

NOTE: The install program should start automatically. If your Windows auto-run 
setting is turned off, choose Start > Run, browse to the CD-ROM drive, 
select the setup.exe file, and click OK. To start the install program from 
a command-line prompt, change to your installation directory and type 
setup.exe -browser=ie.
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2 ♦ The Welcome to PeerDirect Software Installation screen displays. Click START 
INSTALLATION.
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3 ♦ In the Specify the installation location field, enter the full directory path for the 
installation directory. The install program looks in this directory for previously installed 
PeerDirect software and installs updates into the same directory. You can accept the 
default, type a new path, or click Browse to specify an existing directory on your system.

The default installation directory paths are

Platform Run As... Destination

Red Hat Linux ROOT /usr/local/peerdirect

Microsoft Windows ADMIN PRIVS C:\Program Files\PeerDirect
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4 ♦ The install program recognizes the components you have installed and lets you change 
your installation. 

a) Review the list of PeerDirect components that are available to update. 

b) To update the PeerDirect Replication Engine (PDRE), click the Update radio button. 
If you do not want to update PDRE at this time, click Ignore (default).

c) Check which PDRE components you want installed or updated with PDRE.

d) Check the Install Documentation (default) checkbox to install or update the 
PeerDirect Replication Engine Tutorial and online Developer’s Guide and 
Reference (available on Windows only) in the peerdirect\pdre\docs directory 
on your system. You can then access PeerDirect documentation from the Start menu 
on your desktop (Start > Programs > PeerDirect > Documentation).

e) Check PDRE Designer (default) to install the PeerDirect Replication Designer 
(PRD). This component is needed to deploy a PeerDirect Replication Network. 
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f) On Linux, in the Specify the component account field, enter a user name. This user 
name will be able to run the PeerDirect Replication Engine daemon. If the name you 
specify does not exist, check Create New User to automatically create and add it to 
your system.

5 ♦ Click Install.

6 ♦ The install program lists each component as it installs and shows you the progress of the 
installation. 

7 ♦ When the installation completes, close your browser window.

You’ve successfully updated your PeerDirect software.
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2.7 Uninstalling the SDK

To uninstall the Distributed Enterprise SDK

On Windows, choose Start > PeerDirect > Uninstall from the Start menu on your desktop. 

On Linux, log in as root and use the script <install_dir>/uninstall

where <install_dir> is the directory path for your PeerDirect installed components.

2.8 What’s Next
You’ve successfully installed the SDK and are now ready to begin development work. You’ll 
find useful information for developers in the PeerDirect Developer’s Guide and Reference 
(available on the Windows platform). We also recommend that you read the PeerDirect 
Replication Engine Tutorial Guide. Both documents are located in the docs directory of the 
PeerDirect installation CD-ROMs and are available by choosing Start > Programs > 
PeerDirect > Documentation from your desktop Start menu.
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3
Building a PeerDirect Deployment Kit

This chapter describes how to build a deployment kit that embeds your business applications 
and scripts into a PeerDirect InnerEdge or OuterEdge Server install program. This chapter 
includes the following sections:

• About the PeerDirect Application Install Builder Tool

• About the Create Deployment Kit Option

• Setting Up Components to Add to a Deployment Kit

• Setting Up Scripts for a Components File

• Creating a PeerDirect Deployment Kit

• Modifying a Deployment Kit
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3.1 About the PeerDirect Application Install Builder Tool
The PeerDirect Install Builder Tool allows developers to customize the installation of 
applications and other software on PeerDirect InnerEdge and OuterEdge Servers. In a typical 
PeerDirect Replication Network, InnerEdge Servers are connected to multiple remote sites that 
are running OuterEdge Servers. Each OuterEdge Server must be compatible with the InnerEdge 
Server it replicates with and must be configured appropriately to replicate with the other sites 
in its network. PeerDirect provides an easy deployment kit to help you prepare each site for 
replication.

By using the PeerDirect Install Builder Tool, you can develop one install program that contains 
all the correct software components for easy deployment to replication sites. The installation is 
user-friendly and easy for application end users to run. 

Building a deployment kit lets you control which software components are installed. You can 
embed new releases of application files, patches, and configuration set-up scripts. The final kit 
you build can be downloaded from your Web site or delivered to each site on a CD-ROM. Each 
kit contains the PeerDirect software required to set up replication. 

You do not need special software to run the PeerDirect Install Builder Tool. It’s built right into 
your PeerDirect Distributed Enterprise SDK install program. You perform the same steps as if 
you were getting ready to install — you select the components you want to install, and create 
an initial kit staging area by clicking Install. When you’re ready to create the final kit, you click 
Create Kit. This option creates the install kit in a directory you select. Later you can return to 
the kit and make changes if you choose. When you’re ready to deploy, the final kit can be copied 
to a CD-ROM or placed on your Web-site for downloading. A kit contains only the components 
installed into the kit staging area. Therefore, if you change the component configuration of your 
kit, you must click Install again and then create the kit again by clicking Create Kit. For 
detailed instructions, see “To create a deployment kit.”

The PeerDirect Install Builder Tool is available on both the Red Hat Linux and Microsoft 
Windows platforms.

NOTE: If you plan to build a deployment kit, PeerDirect recommends that you install onto a 
machine where there is no other instance of PDRE running and choose the Create 
Deployment Kit option (you cannot create kits from a Quick or Custom installation). 
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3.2 About the Create Deployment Kit Option
To create a deployment kit, start the PeerDirect SDK install program and select the Create 
Deployment Kit option. Make sure that you create your deployment kit on a machine 
where you’ve not previously installed PeerDirect software.

The Create Deployment Kit option lets you select the components you want in the kit and 
also lets you add new components, such as application files and set-up scripts, to the final 
install kit. 

Figure 1-1 shows the Create Deployment Kit stages. The SDK install program asks you to 
select components to install into a kit staging area on your local system. 

Figure 3–1: Workflow for Creating a Deployment Kit
33



PeerDirect Distributed Enterprise SDK Installation Guide
The PeerDirect Create Deployment Kit option follows this workflow to build a deployment kit: 

1. Create a Kit Staging Area — select and install an initial set of kit components into a kit 
staging area. See Figure 3–1 - Step 1. 

2. Verify Kit Components — the SDK install program shows you the components you 
currently have installed in the kit staging area and gives you options to reconfigure the kit 
if you need to (see Figure 3–1 - Step 2). You can also add new components. 

3. Modify Kit and Reinstall — if you’ve changed your kit configuration, you must click 
Reinstall. This action installs a new configuration into the kit staging area. Then verify 
your components and make sure you now have the deployment configuration you want for 
your PeerDirect Replication Network sites. You may iterate kit changes as many times as 
you like. Each time you change your kit components, make sure you click the Reinstall 
button so that your changes are placed into the kit staging area.

4. Create Final Kit — after you verify that the components you selected are correct, click 
Create Kit. The program creates the kit in a directory that you specify. 

When you’re ready, you can copy the kit directory to a CD-ROM for distribution to remote sites 
or zip it for downloading on your Web site. On Linux, you can tar the kit directory or create an 
ISO file for general deployment.

In the following sections of this chapter, you’ll find step-by-step instructions for creating and 
modifying a PeerDirect deployment kit. 

3.3 Setting Up Components to Add to a Deployment Kit
Each component you add to a PeerDirect Deployment Kit must be organized in a separate 
directory and must contain the following folders, files and scripts:

– linux (folder) — place all install objects for the Linux platform in this folder.

– MSWin32 (folder) — place all install objects for the Microsoft Windows NT-based 
platforms in this folder.

NOTE: Use the templates provided by PeerDirect to create your folders and files. You can 
include both the linux and the MSWin32 folders in a component directory if you are 
deploying on both platforms. If you are deploying on only one platform, include only 
the appropriate folder for that platform.

– Component (file) — contains basic information about the component and includes 
script names and locations, and configuration parameters. 
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– Configuration (file) — records the current values for component options. These 
values override any default values that are set by parameters in the Component file. 

– Order (file) — (optional) specifies the order in which components will be displayed 
in an install program window. If the Order file is empty or not present, the ordering 
of components is alphabetical.

– Perl scripts — one or more scripts used to control component operations. Each script 
is passed a dictionary of option name value pairs defined for the component and 
returns either a pass or failure code. Because the scripts are referred to by filename 
using the SCRIPT command in the Component file, scripts must reside in the same 
directory as the Component file.

– all pristine sources — after you add new components and scripts, and click Install, 
the installer tool adds PeerDirect files and executable files to the kit.

For example, in the PeerDirect\samples directory, you’ll find the apache component 
folder. The apache folder contains the following folders and files:

If you want to change a component after you’ve added it to a kit staging area, do one of 
the following:

• Give the newer version of the component a new name and add it to the kit; next 
remove the older version from the kit.

• Re-add the component using the same name.

• Update the component by writing a script to create the updates and run this 
script at installation time.

Folders Files

MSWin32 Configuration

linux Order

apache.pl
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To set up a component to add to a Deployment Kit

1 ♦ Create a directory to contain the components you want copied to the kit staging area. You 
can create this directory anywhere on your system. For example, you could create a 
"MyKit" directory in the PeerDirect installation directory: C:\Program 
Files\PeerDirect\MyKit. 

2 ♦ In this new directory, create one or both of the following folders:

a) If you are deploying the kit to Win32 systems, create a new folder and name it 
"MSWin32". 

b) If you are deploying the kit to Linux systems, create a new folder and name it "linux".

Everything you place in these folders will get copied to the installation area; for example, 
executable files and configuration scripts can be placed in these folders.

3 ♦ Place installation objects for each platform into the corresponding platform folders you 
created in Step 2.

4 ♦ Create a "Component" file. See “Setting Up Scripts for a Components File” below.

5 ♦ Create a "Configuration" file. See “Examples of Files in a Component Directory” below.

6 ♦ Create the PL (Perl) file that will be used in the script commands in the "Component" file. 
See “Examples of Files in a Component Directory” below.

7 ♦ Optionally, create an "Order" file to specify the order you want components displayed on 
the installer screen. See “Examples of Files in a Component Directory” below.

3.4 Setting Up Scripts for a Components File
You might want to write scripts for your component. To tell the install program which scripts 
to run and where they are located, you place basic information (such as script names and 
locations, and configurable parameters) into the Component file (see above) using script 
commands and param statements. 

The following table lists available script commands and describes what they do. Certain script 
commands have a required order. Please refer to the script command examples in “Component 
File” below for examples and the correct ordering of commands.
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Table 3–1: Script Commands

script 
commands Description

final gives a component an opportunity to do whatever it needs to 
after all the components have been installed and started. An 
example is loading a database with starter data.

checkOK checks the values specified by the user in component GUI 
fields and ensures they are valid.Returns appropriate results 
and/or error messages. Preceded by the configgui script.

configgui responsible for the graphic user interface for each component 
that displays in the installer. 

doconfig if checkOK returns no errors, stores the values submitted by the 
user in preparation for installation. Preceded by the checkOK 
script.

install moves the component executable file and files from the install 
staging area to the specified installation location. 

postinstall responsible for actions after an install such as setting the 
environment, setting the registry, and installing menu and 
desktop shortcuts.

postuninstall responsible for actions after an uninstall such as restoring the 
environment, cleaning the registry, and cleaning the menu and 
desktop shortcuts. 

permit checks required resources, such as ports, to ensure they are 
available.

preinstall responsible for actions that happen before the install, for 
example, fetch, patch and build steps. 

• Fetch - consists of moving PeerDirect pristine sources 
from their pre-install location to the Component 
directory. 

• Patch - modifies the sources locally by applying the 
configuration values.

• Build - preforms any final build procedures required.
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3.4.1 Examples of Files in a Component Directory
The following are examples of a Component, Configuration and Order files that you would 
include in your Component directory.

Configuration File 

The example below shows the current values for the title and version of the component, which 
subdirectory it is installed into, and allocated disk space size. These values override any default 
values that might be set by parameters in the Component file.

Example:

title Apache

version 1.36

installSubDir apaches

files 800

space 3072

preserve responsible for preserving data during an update operation. 
Data is typically stored locally, then restored by the restore 
script.

preuninstall performs operations before an uninstall.

restore allows the component to perform any data conversion tasks that 
require the new version of the component. Data is typically 
obtained locally as created by the preserve script. Preceded by 
the preserve script.

start starts the component.

stop stops the component.

uninstall performs uninstall tasks such as moving and deleting files. The 
uninstall script 

Table 3–1: Script Commands

script 
commands Description
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Component File 

The Component File contains information about the component and includes script names and 
their locations, and configuration parameters. Command statements in a component file use the 
following syntax:

Example:

script preserve apache.pl Apache::preserve

script stop apache.pl Apache::stop

script permit apache.pl Apache::permit

script preinstall apache.pl Apache::preinst

script uninstall apache.pl Apache::uninst

script install apache.pl Apache::install

script postinstall apache.pl Apache::postinst

script profile apache.pl Apache::write_profile

script start apache.pl Apache::start

script restore apache.pl Apache::restore

script configgui apache.pl Apache::configgui

Type Syntax Description

script The syntax for script commands is

script <command> <perl_filename> 
<comp_title>::<command_name>

where <command> is one of the script commands listed in Table 3–1, 
<perl_filename> is the name of the PL file that runs the script command, 
<comp_title> is the name of the component, and <command_name> is the 
script command name, such as install and stop.

The script commands in the following example are shown in their required 
order.

param The syntax for param statements is

param <name> <type> [<values>] [<default>]

where <name> is the name of the parameter you want to set, <type> is 
the data type of the accepted value, <values> is one or more values set 
by the parameter, and <default> is the default value set for the 
parameter.
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script doconfig apache.pl Apache::doconfig

script checkOK apache.pl Apache::checkOK

param port int 0 - 80

param user string

param createok int 0 1 0

Order File 

The Order file specifies the order in which components will be displayed in an install program 
window. If the Order file is empty or does not exist, components display in alphabetical order.

Example:

apache

pdre

3.5 Creating a PeerDirect Deployment Kit
Follow these instructions if you are creating a deployment kit for the first time or creating a kit 
staging area in preparation for creating a kit. Also see “About the Create Deployment Kit 
Option.”

To modify an existing deployment kit, see “Modifying a Deployment Kit” below.

To create a deployment kit

1 ♦ Follow instructions specific to your platform below:

• Linux — Log on as ROOT (superuser). Load and mount the PeerDirect Distributed 
Enterprise SDK installation CD-ROM.

The install program should start. If the install program does not start, open the 
CD-ROM directory and run ./setup.

• Windows — Log on to a Windows server or client machine. You must have 
administrative privileges to run the install program. Insert the PeerDirect SDK 
installation CD into your CD-ROM drive

The install program should start automatically. If your Windows auto-run setting is 
turned off, choose Start > Run, browse to the CD-ROM drive, select the 
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setup.exe file, and click OK. To start the install program from a command-line 
prompt, change to your installation directory and type setup.exe -browser=ie.

2 ♦ The Welcome to PeerDirect Software Installation 6.1 screen displays. Click START 
INSTALLATION.

3 ♦ In the Specify the installation location field, enter the full directory path for the 
installation directory. You can accept the default, type a new path, or click Browse to find 
an existing directory on your system. The install program will install the PeerDirect SDK 
in this directory. The default installation directory paths are

Platform Run As... Destination

Red Hat Linux ROOT /usr/local/peerdirect

Microsoft Windows ADMIN PRIVS C:\Program Files\PeerDirect
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NOTE: For ease of creation and iterative development of a deployment kit, PeerDirect 
recommends that you install into a directory that is dedicated to the task of creating 
a kit. 

4 ♦ Click Continue.
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5 ♦ If this is the first time you are running the install program, read the PeerDirect license 
agreement carefully. This screen does not display when you rerun the install program to 
update installation components.

• If you agree to the license, scroll to the bottom of the page and click ACCEPT to 
launch the install program. Proceed to Step 5.

• If you do not agree to the license, scroll to the bottom of the page and click 
DECLINE to exit.
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6 ♦ Select Create Deployment Kit and click Continue.
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7 ♦ In the Configure the following Components screen, do the following:

a) Review the list of PeerDirect components that you can select to install. 

b) To install the PeerDirect Replication Engine (PDRE), check Install (default). If you 
do not want to install PDRE at this time, check Remove.

c) Check Install Documentation to install the PDRE documentation into the kit 
staging area.

d) On Linux, in the Specify the component account field, type a user name. This user 
name will be able to run the PeerDirect Replication Engine daemon. You may enter 
a user or account name. Check Create New User if you want the install program to 
create the user name or account you specify.

NOTE: On Linux, you are asked to specify a user name. The user name is an individual or 
an account that is able to run the PeerDirect Replication Engine (PDRE) daemon. If 
you want multiple persons to be able to execute the PDRE component daemon, 
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specify a user name to own it and attach that user to a group. You can then attach 
other users who need to administer the daemon to the same group.

8 ♦ (Optional) To add a new component:

a) (In the Components Directory field, enter the full directory path to the directory that 
contains the component files and folders you want to add or click Browse 
Components to find the directory on your system. 

b) Click Add Component to have the specified component copied to the kit staging 
area (see “Setting Up Components to Add to a Deployment Kit” and “Setting Up 
Scripts for a Components File.” 

c) The screen refreshes and shows the added component.

d) Repeat Step a to add multiple new components.

9 ♦ When you’re ready to install the components to the kit staging area, click Install.
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10 ♦ The install program lists each component as it installs and shows you the progress of the 
installation. When the installation completes, click Continue.
47



PeerDirect Distributed Enterprise SDK Installation Guide
11 ♦ In the next form, do the following:

a) Review the list of PeerDirect components that you selected. The kit will be a copy of 
the installation in the kit staging area. Therefore, if you make a change to the 
components, you must perform a new "Install" before you can create a kit.

b) Specify how you want each component managed by selecting one of the following:

• Install — installs the component as part of the kit.

• Remove — removes the component from the kit. This option removes the 
component from the kit staging area. Because the kit is created using 
components in the kit staging area, the component is not included in the final 
deployment kit.

12 ♦ When you’re ready, do one of the following:

• To reinstall selected components into the kit staging area (required if you change 
your kit configuration), click Reinstall. Go to Step 10.
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• To create a deployment kit, click Create Kit. Go to Step 13.

13 ♦ In the Select the Kit location field, enter the full directory path for where you want the kit 
created. 

14 ♦ In the Select the Kit Installation location field, enter the full directory path where you 
want the kit installed by end users. This ensures that the kit software installs in the same 
directory on each computer.

15 ♦ Click Create Kit.
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16 ♦ The install program lists each component as it creates the kit.

17 ♦ Please close the browser window when the program completes.
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3.6 Modifying a Deployment Kit
PeerDirect gives you the ability to build a deployment kit that you can use to distribute your 
application software along with the PeerDirect software that will replicate it. You can iterate 
development of a kit by opening a previous kit you created. The PeerDirect Application Install 
Builder tool will tell you which components are already included in the kit. You can then add 
or remove components to create a new kit. 

NOTE: When building a kit, the Application Install Builder tool does not retain any custom 
configurations you may have set up for components. Each kit is built using 
unmodified component sources to ensure the quality of the final kit. For this reason, 
you must always re-install any changed component configuration to the kit staging 
area before you build a final kit. See “About the Create Deployment Kit Option.”

NOTE: Because the Application Install Builder Tool does not retain any custom 
configurations you set, anything you need to preserve should be in a script.

To modify a deployment kit

1 ♦ Follow instructions specific to your platform below:

• Linux — Log on as a root (superuser). Start the PeerDirect SDK install program. 
You can load and mount the PeerDirect SDK installation CD-ROM or if already 
installed, run the ./setup file from your installation directory. 

If the install program does not start, open the CD-ROM directory and run ./setup.

• Windows — Log on to a Windows server or client machine. Start the PeerDirect 
SDK installation program. You can insert the PeerDirect SDK installation CD into 
your CD-ROM drive or if already installed, run the setup.exe file in your 
installation directory.

The install program should start automatically. If your Windows auto-run setting is 
turned off, choose Start > Run, browse to the CD-ROM drive, select the 
setup.exe file, and click OK.

2 ♦ Click Start Installation.

3 ♦ Select Create Deployment Kit and click Continue.
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4 ♦ Specify the same installation directory path you used for the previous deployment kit you 
installed. Click Continue.
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5 ♦ The next screen shows you the kit components in your kit staging area.

6 ♦ To make changes to the kit, begin with Step 11 in “Creating a PeerDirect Deployment Kit” 
above and follow the instructions for modifying your kit configuration and creating a new 
kit.
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3.6.1 Example of a Deployment Kit
The deployment kit you create installs the components you’ve included in the kit (listed at the 
top of the install screen) and gives the end user a single "Start Installation" button that installs 
everything.
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After the end user starts the installation, a screen displays messages that give the user status.

When the installation completes, the end user closes the browser. 

3.7 What’s Next
The next chapter describes how to set up replication for InnerEdge and OuterEdge Servers and 
Workstations. Please read this chapter and also the PeerDirect Replication Engine Tutorial 
(Start > Program > PeerDirect > Documentation).
55



PeerDirect Distributed Enterprise SDK Installation Guide
56



4
Setting Up PeerDirect Replication

This chapter describes how to set up PeerDirect replication using your PeerDirect SDK 
software. It will take you through each phase of the PeerDirect Replication Engine set up and 
includes these sections: 

• Overview

• Database Considerations

• Setting Up Databases for Replication

• About Preparing Databases for Activation

• Initiating a Replication Session

• Administering a Replication Network

• What’s Next
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4.1 Overview
All successful replication networks begin with a deployment strategy and plan. Begin by 
considering the different layout options that PeerDirect offers and choose the one that offers you 
the benefits and features you need. You’ll find basic network layout designs described in 
Chapter 1 and in the PeerDirect Replication Engine Tutorial guide.

The initial setup of a replication network requires that you install the PeerDirect Replication 
Designer (PRD) available in the Windows PeerDirect SDK product. You need the PeerDirect 
Replication Designer (PRD) to define the replication rules for the database. These rules allow 
the PeerDirect Replication Engine (PDRE) to know what and how the data is to be synchronized 
between two or more sites within a PeerDirect Replication Network.

You next export the replication rules you define to a file and apply it against an InnerEdge 
Server or OuterEdge Server | Workstation database using the dimprule utility. This step enables 
the database for replication and prepares it for activation into a PeerDirect Replication Network. 
To activate the database, you use the dinst utility. The dimprule and dinst utilities are present in 
both the Windows and Linux versions of PDRE 6.1.

This chapter provides detailed instruction steps for both the InnerEdge and OuterEdge Servers. 
See “Setting Up Replication on an InnerEdge Server” and “Setting Up Replication on an 
OuterEdge Server or Workstation” below. 

4.1.1 Setting Up Replication on an InnerEdge Server
You must define replication rules before you can complete setup of the first InnerEdge Server 
site. To set up replication on the first Inner Edge Server, complete these steps:

1 ♦ Install the PeerDirect Distributed Enterprise SDK software and use the PeerDirect 
Replication Designer to create replication rules. See the PeerDirect Distributed Enterprise 
SDK Installation Guide and the Developer’s Guide and Reference for information about 
how to create rules.

2 ♦ Install an InnerEdge Server running PDRE on a primary datacenter server that hosts the 
database with which you plan to replicate OuterEdge Servers. Refer to the PeerDirect 
InnerEdge Server Installation Guide for installation instructions.

3 ♦ Set up database logins and permissions so that PDRE can access the required data for 
replication. See “Setting Up Database Logins and Permissions.”

4 ♦ Using the dimprule utility, prepare to activate the database. See “To prepare to activate 
an InnerEdge Server using the dimprule utility.”

5 ♦ Using the dinst utility, activate the InnerEdge Server site. See “To activate the database 
at the InnerEdge Server site.”
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NOTE: You must activate the site on the InnerEdge Server first and then activate the site on 
the OuterEdge Server.

4.1.2 Setting Up Replication on an OuterEdge Server or 
Workstation

You should already have installed one InnerEdge Server on a primary server that hosts the 
database you plan to use to replicate data. If you chose Method A (see the “Overview”), you 
should also have completed the preparation of your first InnerEdge Server database and 
activated the site. 

If you chose Method B, after you install both the InnerEdge and OuterEdge Servers, the next 
step is to complete setup of the InnerEdge Server (see previous section) and then setup the 
OuterEdge Server.

To set up replication on an OuterEdge Server or Workstation, complete these steps:

1 ♦ Install an OuterEdge Server or Workstation that runs PDRE. Refer to the PeerDirect 
OuterEdge Server Installation Guide for installation instructions.

2 ♦ Set up database logins and permissions so that PDRE can access the required data for 
replication. See “Setting Up Database Logins and Permissions.”

3 ♦ Prepare the OuterEdge Server | Workstation database. See “To prepare to activate the 
database on the OuterEdge Server.”

4 ♦ Activate the OuterEdge Server | Workstation site. As part of this process, the first 
replication session will be initiated automatically. See “To prepare to activate the database 
on the OuterEdge Server.” 

After the first replication, you can use the PeerDirect Administrator (PDA) console to set up the 
PeerDirect Replication Engine to automatically replicate data on schedule. 
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4.1.3 Setup Task Sequence
Setting up a PeerDirect Replication Network requires that you perform a sequence of tasks. 
There are two ways to perform this sequence. You can choose to set up your replication sites 
one by one, beginning with your first InnerEdge Server (see Table 4–1) or you can perform all 
your installation tasks first and then prepare and activate each site separately (see Table 4–2). 
You should choose the method that you think works best for your particular deployment 
purposes. The following tables describe the two methods. For detail instructions, please refer to 
the referenced resources.

Table 4–1: Method A- Sequence of Replication Network Setup Tasks

Step Task Description

1 Plan Replication Network Plan and design your distributed 
application system and replication 
network as an up front activity. Review 
your database configuration and schema 
design to make sure it meets the 
PeerDirect requirements for replication of 
data. 

You’ll find some typical replication 
network layouts described in Chapter 1, 
“Welcome to PeerDirect Distributed 
Enterprise SDK” and in the PeerDirect 
Replication Engine Tutorial.

2 Install the Distributed 
Enterprise SDK 
(Windows version)

When you install the SDK, you must also 
install the PeerDirect Replication 
Designer (PRD) to create the database 
rules for your PeerDirect Replication 
Network.

The PRD is only available as part of the 
PeerDirect Distributed Enterprise SDK 
software product. 

This guide describes how to install the 
PeerDirect SDK.

3 Define Replication Rules Use the PeerDirect Replication Designer 
(PRD) to define the database replication 
rules for your PeerDirect Replication 
Network. See the PeerDirect Replication 
Engine Tutorial and Developer’s 
Reference Guides.
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4 Export Replication Rules After you’ve created replication rules and 
are satisfied, select Tools > Prepare to 
Activate and then File > Export Rules. 
This exports the rules to a rules file that 
you use to set up your replication 
databases at each site. See “To export 
rules.”

5 Install the InnerEdge 
Server as the first site

Install the InnerEdge Server on a central 
data server that is highly available to the 
other sites in your PeerDirect Replication 
Network. See the PeerDirect InnerEdge 
Server Installation Guide.

6 Prepare the InnerEdge 
Server database

Prepare the first site database using the 
dimprule utility. Be sure to use the 
-FIRSTSITE parameter. See “Preparing 
to Activate Your Replication Sites.”

7 Activate the InnerEdge 
Server site

Activate the InnerEdge Server site using 
the dinst utility. Be sure to use the 
-FIRSTSITE parameter. See “Activating 
the InnerEdge Server Database.”

8 Install an InnerEdge 
Server or OuterEdge 
Server | Workstation as a 
second site

After you install and activate your first 
site, install your second replication site.

Later, you’ll repeat this step for the other 
sites in your replication network. See the 
PeerDirect InnerEdge Server or 
OuterEdge Server and Workstation 
Installation Guides.

9 Prepare the InnerEdge 
Server or OuterEdge 
Server | Workstation 
database as a second site

Prepare the second site’s database by 
using the dimprule utility.

Later, you’ll repeat this step for all 
remaining sites you’ve installed as part of 
your replication network. 

See “To prepare to activate the database on 
the OuterEdge Server.”

Step Task Description
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Table 4–2: Method B - Sequence of Replication Network Setup Tasks

10 Activate the InnerEdge 
Server or OuterEdge 
Server | Workstation site 
as a second site

Activate the second site using the dinst 
utility. As part of this process, the initial 
replication session is started with the first 
site.

Later, you’ll repeat this step for all 
remaining sites.

See “To prepare to activate the database on 
the OuterEdge Server.”

11 Repeat Step 7 - 9 to install, 
prepare and activate the 
remaining sites in your 
replication network.

Repeat steps 7 - 9 until all replication sites 
in your PeerDirect Replication Network 
are installed, prepared and activated. 

Step Task Description

1 Plan Replication Network Plan and design your distributed 
application system and replication 
network as an up front activity. Review 
your database configuration and schema 
design to make sure it meets the 
PeerDirect requirements for replication of 
data.

You’ll find typical replication network 
layouts described in Chapter 1, “Welcome 
to PeerDirect Distributed Enterprise SDK” 
and in the PeerDirect Replication Engine 
Tutorial.

2 Install the Distributed 
Enterprise SDK 
(Windows version)

You must install the PeerDirect 
Replication Designer (PRD) to create the 
database rules for your PeerDirect 
Replication Network.

The PRD is only available as part of the 
PeerDirect Distributed Enterprise SDK 
software product.

This guide describes how to install the 
PeerDirect SDK.

Step Task Description
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3 Define Replication Rules Use the PeerDirect Replication Designer 
(PRD) to define the database replication 
rules for your PeerDirect Replication 
Network. This is where the work you did 
in Step 1 pays off. See the PeerDirect 
Replication Engine Tutorial and 
Developer’s Reference Guides.

4 Export Replication Rules 
to a File

After you’ve created replication rules and 
are satisfied, select Tools > Prepare to 
Activate and then File > Export Rules. 
This exports the rules to a rules file that 
you use to set up your replication 
databases at each site. See “To export 
rules.”

5 Install the InnerEdge 
Server as the first site

Install the InnerEdge Server on a central 
data server that is highly available to the 
other sites in your PeerDirect Replication 
Network. 

See the PeerDirect InnerEdge Server 
Installation Guide for more information.

8 Install an InnerEdge 
Server or OuterEdge 
Server | Workstation on 
the second and remaining 
sites in the network

After you install and activate your first 
site, install your second replication site.

Repeat this step for the other sites in your 
replication network.

See the PeerDirect InnerEdge Server or 
PeerDirect OuterEdge Server and 
Workstation Installation Guides for more 
information.

6 Prepare the InnerEdge 
Server database as the 
first site

Prepare the first site database the dimprule 
utility. Be sure to use the -FIRSTSITE 
parameter.

See “Preparing to Activate Your 
Replication Sites” in this chapter for more 
information.

Step Task Description
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Each InnerEdge Server and OuterEdge Server | Workstation runs a PeerDirect Replication 
Engine (PDRE) component that replicates data among the databases in your PeerDirect 
Replication Network. You can select to install PDRE on your server or workstation when you 
run the PeerDirect install program (on Windows, select the Runtime edition). 

For instructions about how to install an OuterEdge Server, see the PeerDirect OuterEdge Server 
Installation Guide available on the OuterEdge installation CD-ROM. For instructions about 
installing an InnerEdge Server, please refer to the PeerDirect InnerEdge Server Installation 
Guide included on your InnerEdge Server installation CD-ROM. All documentation is located 
in the docs directory at the top-level or root of each installation CD-ROM.

7 Activate the InnerEdge 
Server site as the first site

Activate the InnerEdge Server site using 
the dinst utility. Be sure to use the 
-FIRSTSITE parameter.

See “To activate the database at the 
InnerEdge Server site” in this chapter for 
more information.

9 Prepare the InnerEdge 
Server or OuterEdge 
Server | Workstation 
database on the second 
site and remaining sites in 
the network

Prepare the second site’s database by 
using the dimprule utility.

Repeat this step for all remaining sites 
you’ve installed as part of your replication 
network. 

See “To prepare to activate the database on 
the OuterEdge Server” for more 
information.

10 Activate the InnerEdge 
Server or OuterEdge 
Server | Workstation site 
on the second site and 
remaining sites in the 
network

Activate the second site using the dinst 
utility. As part of this process, the initial 
replication session is started with the first 
site.

Repeat this step for all remaining sites.

See “To prepare to activate the database on 
the OuterEdge Server” for further 
instruction.

Step Task Description
64



Setting Up PeerDirect Replication
4.1.4 Recommendations
You’ll find instructions in this chapter for setting up replication on both the PeerDirect 
InnerEdge and OuterEdge Servers. As you work, it is important that you follow the instructions 
from first to last step in the sequence in which they are presented. Do not skip any steps. 

We strongly recommend that you read the PeerDirect Replication Engine Tutorial Guide 
located in the docs directory of the PeerDirect InnerEdge Server installation CD-ROM. This 
guide provides detailed and complete information about setting up and configuring the 
PeerDirect Replication Engine (PDRE). If you are reading the PeerDirect Replication Engine 
Tutorial, the instructions in this chapter for the InnerEdge Server match the Tutorial instructions 
for the first replication site; instructions for the OuterEdge Server match the Tutorial 
instructions for the second site.

4.2 Database Considerations
When replicating databases with the PeerDirect Replication Engine, please follow these 
recommendations:

Homogeneous and Heterogeneous Replication Networks

When you configure a database to work with PDRE, you have the ability to replicate data 
between databases of the same vendor type (homogeneous), or to replicate with databases that 
are different (heterogeneous), such as a Microsoft SQL Server and an Oracle database. For a list 
of PeerDirect-supported databases, see Table 1–1. 

When you replicate between different vendor-specific databases, you must ensure that the data 
types being used are compatible. Replication will not happen unless the documented “basic data 
type” match for a given field across the two different database platforms. The length and 
precision of each column must also be identical across the two database environments. 

For detailed information about replicating with databases of different types, please refer to the 
PeerDirect Replication Engine Tutorial Guide. See also Chapter 1, “Supported Databases”

Foreign Keys

Foreign keys are important if you wish to impact the order in which keys are replicated. If you 
plan to use work sets, you must use foreign keys. 

It is important that PDRE know the foreign keys for each table involved in replication. Database 
table relationships are defined from the bottom up, that is from the first child to the parent to 
which it is related by a foreign key. PDRE uses this information to determine the order in which 
tables are replicated, as parent tables are always replicated before child tables. Foreign key 
relationships are also used in defining work sets and transaction sets, and to ensure that deletions 
are cascaded to dependent tables. 
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For instructions about how to define foreign keys, see “Specifying Foreign Keys.”

Cascading Table Deletions

If your database includes local (non-replicated) tables that are related to replicated tables, 
cascading deletions will not extend to these local tables. This means that you must either use 
triggers to ensure that deletions are cascaded to local tables and/or you must enable cascading 
deletions in your database software or in your business application. 

Note that if you implement referential integrity constraints between these local and replicated 
tables without ensuring that deletions are properly cascaded to the local table(s), PDRE 
deletions will cause these constraints to “break”.

Consistent Naming

Please ensure that all tables you plan to replicate have the same names across replicated 
databases. This is not a problem if you enable a first database and then copy it to other locations 
that you plan to replicate with. 

Columns in replicated tables must also have identical names, and when replicating between two 
different vendor databases, must have compatible data types. 

There are no requirements for tables or columns that you do not plan to replicate.

Unsupported Data Types

Tables you plan to replicate should not include unsupported data types or associated settings or 
properties. This includes the use of auto increment fields such as Microsoft IDENTITY fields. 
By default, PDRE replicates all columns in a table but you can modify this behavior using a 
feature called fragments. 

For a list of supported data types and database-specific types, please refer to the PeerDirect 
Developer’s Guide and Reference. For information about how to replicate a table that uses 
IDENTITY fields, please see the appendix: "Replicating a Table Containing IDENTITY 
Fields" in the Developer’s Guide.

Unique Primary Keys

All tables you plan to replicate must have a unique primary key. With the exception of Microsoft 
SQL Server, it is not necessary to have primary key constraints physically defined in the 
database. 

To enhance performance, PeerDirect recommends that you set a unique index on each table’s 
primary key. Primary keys may be simple — comprised of a single column — or composite — 
comprised of two or more columns. However, no component of a primary key may contain a 
NULL value. 
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Database Versions

PDRE supports specific versions of most database platforms. Please be sure to consult Table 
1–1 or the Release Notes (relnotes.txt) for the exact versions of your database software that can 
be used with PDRE. If you have an earlier or a later version of the database software than the 
one specified, you may encounter problems if you attempt to use it with PDRE. Please contact 
PeerDirect Technical Support at support@peerdirect.com if you have questions.

Clock Synchronization

The date and time must be set correctly on all machines in a replication network, including all 
database servers, PDRE servers, application servers (machine running database clients), and 
remotely connected machines. PeerDirect recommends that you install and use one of the 
following programs to synchronize the clocks on your machines:

• Tardis (http://www.kaska.demon.co.uk)

• Dimension 4 (http://www.thinkman.com/dimension4/)

4.3 Setting Up Databases for Replication
To set up a PeerDirect Replication Network, you must perform a series of tasks. The sequence 
of these tasks is outlined in the Overview of this chapter. The sections below describe each task 
in detail.

4.3.1 Setting Up Database Logins and Permissions
Both PeerDirect Replication Designer (PRD) and PeerDirect Replication Engine (PDRE) 
require access permissions that allow them to manipulate tables in the database.

Each installed... Requires...

PeerDirect Replication 
Designer (PRD)

access to all application tables to be replicated.

permissions to create and update new tables in the 
database. 

PeerDirect Replication 
Engine (PDRE)

insert/update/delete/select access to all replicated tables, 
all PeerDirect system tables, and all PeerDirect control 
tables in the database.

exclusive use of a specific login ID if you plan to 
implement triggers to maintain control fields.
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If your database requires users to log in, you will need to provide login IDs that have appropriate 
permissions to access and update your database for PRD and PDRE to use.

To create a Login ID with adequate permissions in your database

Before you begin to use PRD or PDRE, we recommend you do the following:

1 ♦ Create a database user called “PDUSER”.

2 ♦ Give PDUSER insert/update/delete/select access to all replicated tables, all PeerDirect 
system tables, and all PeerDirect control tables in the database

3 ♦ Also give PDUSER all permissions equivalent to those of the database owner.

4 ♦ Set up PRD and PDRE to use the PDUSER login ID. 

Alternatively, you can have PDRE use the login ID of the user who owns the database tables 
you want to replicate. Whatever you use, make sure it is a user ID that is only used by PDRE.

NOTE: Do not use an alias or the Microsoft/Sybase “sa” or Oracle “system” user. Do not 
alias the PDUSER login to any other user. 

4.3.2 Selecting Databases to Replicate
You use the PeerDirect Replication Designer (PRD) to select and configure the databases you 
want to replicate with as part of a replication network. 

NOTE: For Microsoft SQL Server, be sure to define primary keys in the database before you 
run PRD, otherwise you will encounter replication errors. 

When you start PRD for the first time, PRD asks you detailed questions about the database, 
connection and replication information, including tables to replicate, and primary and foreign 
keys. 

To select a database to replicate

1 ♦ Start the PeerDirect Replication Designer (PRD). 

NOTE: Starting PRD also starts the PeerDirect Replication Engine. 

2 ♦ The Database Information screen displays. Complete the following fields:

a) Database Type — select the type of database you wish to replicate.
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Table 4–3: Database Type Formats

b) Database Locator — enter the location of the database you wish to replicate. 
Depending on the database type you select, you’ll see one of these formats:

c) Database Connection Information — (optional) if you need a user/login ID and 
password to access your database through ODBC, enter the following information

NOTE: The user name PDUSER must have already been granted the necessary permissions 
to the database.

3 ♦ UserName — enter the user name or login ID required to access the database.

a) Password — enter the password required to access the database.

b) Optional Parameters — enter any additional connection parameters. For example, 
if your database uses a system database to validate users, you must enter its name 
here. The syntax is systemdb=myfile.mdw.

Database Type Format

Borland InterBase Full path to the .GBD file or

<server_name>:<db_name>

IBM DB2 UDB <db_name>

IBM Informix <db_name>:<host>:<server>:<ser
vice_name>:<protocol>

Microsoft SQL Server 6.5, 7.0, 2000 <server_name>:<db_name>[:<extr
as>]

Oracle 8 <server_name>

Oracle 8.1.6 and above <host>:<SID>:<port>

Progress RDBMS 9.1D <host>:<port>:<db_name>

PostgreSQL <server_name>:<port>:<db_name>

Sybase Adaptive Server Anywhere

Sybase SQL Anywhere 5

Full path to .DB file or 
<server_name>[:<db_name>]

where <server_name> is the 
LOCAL for the local database.

Sybase Adaptive Server Enterprise 11.x <server_name>:<db_name>
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4 ♦ Click Next.

5 ♦ The Database Information screen displays. Complete these fields.

a) Project — enter the name of your project.

b) Network — enter the name of the replication network. The network will be 
comprised of the databases you identify for replication.

NOTE: Only databases that are part of the same project and network may replicate together. 
Databases in two different networks will not interact.

6 ♦ Release — enter the name of this release. Each project/network may have multiple 
releases as new replication features are added or database schema changes are 
implemented.

7 ♦ Click Next.

4.3.3 Selecting Tables for Replication
You use the main PRD window to specify which tables to replicate (tables are initially marked 
as “Not Replicated”) and to configure the advanced features of PDRE.

To select tables for replication

1 ♦ In the main PRD window, select the tables in your database that you want to replicate.

2 ♦ Choose Actions > Replicate Table. 

3 ♦ Click the Replicated tab at the bottom of the left panel. The tables you marked for 
replication are shown in the replicated list.

4.3.4 Specifying Foreign Keys
If you have foreign key constraints defined in your database, PRD will automatically detect 
them (except for Oracle). These foreign keys display when you select the Foreign Keys tab. 
You may add more foreign key relationships if you wish.

It is important that PDRE know what the foreign keys are for each table it replicates. Foreign 
keys determine the order in which PDRE replicates tables, replicating parent tables before child 
tables. Foreign keys are also required if you define work sets ad transaction sets. See “Foreign 
Keys” in “Database Considerations.”
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To specify foreign key relationships

1 ♦ In the main PRD window, click the Foreign Key tab.

2 ♦ In the Create new relationship from <TableName> to parent table field, from the 
drop-down menu select a parent table for this child table. The primary key field(s) for the 
parent table and candidate foreign key field(s) display.

3 ♦ Select the appropriate foreign key field(s) that correspond to the primary key field(s).

4 ♦ Click Add Relationship. The relationship is added to the list of Existing Relationships.

Repeat these steps for each foreign key in your database.

To modify a foreign key relationship

1 ♦ Select a relationship from the Existing Relationships list.

2 ♦ Select the primary key and foreign key fields from the drop-down menu.

3 ♦ Click Apply Changes.

To delete a relationship, select the relationship from the Existing Relationships list, and click 
Delete Relationship.

4.3.5 Verifying and Saving Replication Rules
The next step is to verify and save your database’s replication rules. Verifying the database 
performs checks for cyclic dependencies, such as circular foreign key references, and whether 
each replicated table has a primary key specified.

To verify and save database replication rules

1 ♦ In the main PRD window, choose Tools > Verify Rules.

2 ♦ If PRD found errors in your database, they are displayed. Correct them and re-run the 
verify tool. 

3 ♦ Repeat step 2 until all error messages are resolved. 

4 ♦ Choose File > Save. 

NOTE: PRD lets you save your changes even if there are errors, but you cannot continue with 
the next steps unless you correct all errors. To view the error messages, select View 
> Verification Messages.
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4.4 About Preparing Databases for Activation
You must prepare each database in your replication network for activation using the dimprule 
utility. If the first site was prepared for activation by PRD (see “Preparing to Activate With 
PRD”), you do not need to run the dimprule utility.

The dimprule utility 

• writes information to PeerDirect system tables.

• creates a control table for each table you are replicating.

• preprocesses any pre-existing user data — also referred to as starter data— found in 
replicated tables by creating control table records for each user table record. (This 
step is performed at the first InnerEdge Server site but only if you check the Mark 
starter data for replication checkbox, so make sure you check the checkbox.)

NOTE: It is very important that you mark starter data for replication only at your first site, 
which should be an InnerEdge Server site.

PeerDirect recommends that you run PRD in your SDK development environment to create 
replication rules, and then import these rules to the first site of your production environment 
(which should be an InnerEdge Server) using the dimprule utility (see “Preparing to Activate 
Your Replication Sites”). Be sure to specify the dimprule -FIRSTSITE parameter at the first 
InnerEdge Server site.

If you use PRD to activate your first site, you must be sure to check the Mark starter data for 
replication checkbox for InnerEdge Servers. All data in the OuterEdge database(s) will be 
initialized during a special starter data reconciliation phase that occurs during the initial 
replication with the InnerEdge Server database. 
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4.4.1 Preparing to Activate Your Replication Sites
Begin by preparing your first InnerEdge Server for activation. PeerDirect recommends that you 
create your Rule file using PRD in your SDK development environment and then run the 
dimprule utility to prepare your first InnerEdge Server site. 

To prepare to activate an InnerEdge Server using the dimprule utility

Create your rule (.rul) file in PRD before you run dimprule on the first InnerEdge Server site. 

1 ♦ Open a command-line prompt window.

2 ♦ Type the following command:

DIMPRULE -FIRSTSITE -DA=<db_type> -DB=<db_locator> -ODBCN=<username> 

-ODBCP=<password> <rule_file_name.rul> [-logwide] [-v]

where

<db_type> is the type of database to be activated and <db_locator> is the location of 
the database. See Table 4–3.

<username> is the user name you used in the PeerDirect Replication Designer (PRD). 
PDRE will use this name to connect to the SQL database. PeerDirect strongly recommends 
that you use “PDUSER”. See “Setting Up Database Logins and Permissions.”.

<password> is the password that corresponds to the user name above. The parameter is 
optional and defaults to “password". Be sure to enclose the password in double-quotes if 
it contains spaces.

<rule_file_name.rul> is the name of the file you created when you set up the first 
InnerEdge server. You can get the name of this file from that site.

-logwide and -v (verbose) are optional parameters that enable detailed logging activity.

-FIRSTSITE designates this site to be the first site in the replication network and is used 
at only one site per replication network. 

NOTE: The -ODBCN and -ODNCP parameters represent the user ID and password that PDRE 
will use to log in to and access the database. You must therefore have granted 
sufficient permissions to this user ID to allow it to read and update all replicated 
tables in the database. See “Setting Up Database Logins and Permissions.”.

Example for PostgreSQL database: 

dimprule -FIRSTSITE -DA=postgresql 

-DB=outeredge1:5432:db1
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4.4.2 Preparing to Activate With PRD
This preparation lets you export a Rule (RUL) file which the PeerDirect administrator can then 
use to set up and activate other servers. It is important that you create the Rule file for the first 
site you install and then apply the same Rule file to all other databases you plan to replicate with. 
Be sure to write down the name of the Rule file you create for future PDRE installations.

To prepare to activate your InnerEdge Server database

1 ♦ Choose Tools > Prepare to Activate....

2 ♦ If you know the network address of the InnerEdge Server site in your replication network, 
enter it. If you are using single engine replication, you can enter “localhost”.

3 ♦ If you have initial data in the database (starter data), leave the Mark starter data for 
replication checkbox checked. 

4 ♦ Click OK. 

5 ♦ A dialog appears telling you that the database has been prepared for activation. 

6 ♦ Click OK.

To export rules

After you have successfully completed the Prepare to Activate... operation, you must export the 
replication rules to a file. The default file extension is .rul.

1 ♦ Choose File > Export Rules and save the replication rules to a file, such as 
xPD060102.RUL. You must use this rule file to set up other replication sites. 

2 ♦ Exit the PeerDirect Replication Designer.
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4.4.3 Activating the InnerEdge Server Database 
After you’ve prepared the InnerEdge Server, you must prepare the OuterEdge Server and 
associate it with the PeerDirect Replication Engine on the InnerEdge Server. This will activate 
your database, making it available for replication and creating the default PeerDirect 
Administrator account for the site.

To activate the database at the InnerEdge Server site

1 ♦ Open a command-line prompt window.

2 ♦ Type the following command

DINST -DATABASETYPE=<db_type> -DBLOCATOR=<db_locator> 

-ODBCN=<username> -ODBCP=<password> -FIRSTSITE 

-PNLICENSE=<license.pnl>

where

<db_type> is the type of database to be activated and <db_locator> is the location of 
the database. See Table 4–3.

<username> is the user name you used in the PeerDirect Replication Designer (PRD). 
PeerDirect strongly recommends that you use “PDUSER” as the user name. See “Setting 
Up Database Logins and Permissions.”.

<password> is the password that corresponds to the user name above. The parameter is 
optional and defaults to ““. the empty string. Be sure to enclose the password in 
double-quotes if it contains spaces.

-FIRSTSITE designates this site to be the first site in the replication network and is used 
at only one site per replication network. 

-PNLICENSE is the replication network file and specifies the network license to use with your 
replication network. This license is sent to you by PeerDirect Technical Support when you 
purchase your software. If you need assistance, please contact them at 
support@peerdirect.com.

<license.pnl> is the full path and file name of the license. If you do not supply this 
information, a dialog appears asking you to supply the license file location.

NOTE: The -ODBCN and -ODNCP parameters represent the user ID and password that PDRE 
will use to log in to and access the database. You must therefore have granted 
sufficient permissions to this user ID to allow it to read and update all replicated 
tables in the database. See “Setting Up Database Logins and Permissions.”.
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NOTE: For a compete list of DINST arguments and other PDRE utility commands, use the 
“-?” argument; for example, “DINST -?”.

3 ♦ A dialog appears informing you that the activation of the database was successful. 

4 ♦ Click OK. 

5 ♦ In a command-line shell or window, initiate the triggers by typing

DTRIGGER <odbc_datatsource> -ODBCN=<username> -ODBCP=<password>

where

<odbc_datasource> is the name of the data source.

<username> is the user name that PDRE uses to connect to the database. 

<password> is the password that corresponds to the user name above.

4.4.4 Preparing and Activating the OuterEdge Server Sites
This task must be performed from the command-line console of the machine that is running 
PDRE for the OuterEdge Server. Depending on your configurations, this may not be the same 
machine on which the OuterEdge database resides. 

Once activation of the OuterEdge database is completed, the first replication between the 
InnerEdge and OuterEdge Server sites occurs. 

If you are activating the second database at another workstation, you will encounter errors if 
PDRE is not already running at the first site. The first replication at a new site normally takes 
longer than subsequent replications, because PDRE guarantees that all data in common at both 
sites are exactly synchronized. Subsequent replications normally send only what changed.
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To prepare to activate the database on the OuterEdge Server

1 ♦ Open a command prompt window.

2 ♦ You must run dimprule to activate the rule file you created when you set up the first 
InnerEdge Server. To do this, type the following command:

DIMPRULE -DA=<db_type> -DB=<db_locator> -ODBCN=<username> 

-ODBCP=<password> <rule_file_name.rul> [-logwide] [-v]

where

<db_type> is the type of database to be activated and <db_locator> is the location of 
the database. See Table 4–3.

<username> is the user name you used in the PeerDirect Replication Designer (PRD). 
PDRE will use this name to connect to the SQL database. PeerDirect strongly recommends 
that you use “PDUSER”. See “Setting Up Database Logins and Permissions.”.

<password> is the password that corresponds to the user name above. The parameter is 
optional and defaults to “password". Be sure to enclose the password in double-quotes if 
it contains spaces.

<rule_file_name.rul> is the name of the file you created when you set up the first 
InnerEdge server. You can get the name of this file from that site.

-logwide and -v (verbose) are optional parameters that enable detailed logging activity.

Example for PostgreSQL database: 

dimprule -DA=postgresql -DB=outeredge1:5432:db1
77



PeerDirect Distributed Enterprise SDK Installation Guide
To activate an OuterEdge Server site

Use the dinst utility to activate the OuterEdge Server site.

1 ♦ Type the following DINST command:

DINST -DATABASETYPE=<db_type> -DBLOCATOR=<db_locator> 

-ODBCN=<username> -ODBCP=<password> -SITETYPE=<site_type> -PA 

=<first_PDRE_site>

where

-SITETYPE specifies one of the following values. For an OuterEdge Server, select either 
LOW or HIGH. Select COMPLETE only if you are configuring your OuterEdge Server to 
be a failover server.

a) LOW — (default) site is available only for replication from time to time. 

b) HIGH — site is available for replication at all times. 

c) COMPLETE — site is available for replication at all times and the database stores 
ALL of the data in the replication network, that is all work set slices are 
auto-subscribed to.

-PA specifies the first PDRE site you installed, which should also be the first InnerEdge 
Server site installed.

NOTE: The -ODBCN and -ODNCP parameters represent the user ID and password that PDRE 
will use to log in to and access the database. You must therefore have granted 
sufficient permissions to this user ID to allow it to read and update all replicated 
tables in the database. See “Setting Up Database Logins and Permissions.”

For a compete list of DINST arguments and other PDRE utility commands, use the “-?” 
argument; for example, “DINST -?”.

2 ♦ A dialog appears informing you that the activation of the database was successful. 

3 ♦ Click OK. The first replication between the InnerEdge Server and OuterEdge site occurs. 

NOTE: If you are activating the OuterEdge Server database at another workstation, you will 
encounter errors if PDRE is not already running on the InnerEdge Server. The first 
replication at a new site normally takes longer than subsequent replications, because 
PDRE guarantees that all data in common at both sites are exactly synchronized. 
Subsequent replications normally send only what changed.
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4 ♦ In a command-line shell or window, initiate triggers by typing

DTRIGGER <odbc_datatsource> -ODBCN=<username> 
-ODBCP=<password>

where

<odbc_datasource> is the name of the data source.

<username> is the user name that PDRE uses to connect to the database. 

<password> is the password that corresponds to the user name above.

NOTE: This step is not necessary for a Progress replication network.

4.5 Initiating a Replication Session
PDRE initiates replication data bidirectionally from either the InnerEdge Server or the 
OuterEdge Server. If your PeerDirect-prepared databases have activated successfully, follow 
these directions to initiate further replication sessions. 

1 ♦ Open the PDRE user interface.

2 ♦ Choose Action > Initiate Replication. 

3 ♦ The Initiate Replication dialog displays. Select the database you want to initiate, 
typically the second database site. 

4 ♦ Click Replicate Now.

If one of the replication sites has a site type of LOW, PDRE may tell you that it is unable 
to find a suitable replication partner site. This happens if you select a HIGH site and click 
Replicate Now, because LOW sites are never chosen by default as partner sites. If you 
want to initiate replication from a HIGH site to a LOW site, you must use the Advanced 
button and explicitly select the two sites you want to replicate between. The easiest way 
to avoid this message is to always select the LOW site and initiate the replication from the 
LOW site to the HIGH site. 
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4.6 Administering a Replication Network
To administer a replication network, the Windows PeerDirect Administrator is required. This 
application is used to schedule or subscribe to work set slices (see the PeerDirect Replication 
Engine Tutorial for information about how to create and use work slices).

If your replication network is running on Linux, you must install the Windows PeerDirect 
InnerEdge or OuterEdge Server. When you install, choose the Custom Installation option and 
the Client Access Edition. When you’ve completed the installation, then you can activate a 
client database site by using the dinstc utility. This will allow the PeerDirect Administrator to 
connect to a PeerDirect Replication Engine on Linux and remotely administer the specified 
database in the network.

4.7 What’s Next
You’ve successfully set up PDRE and can perform your first replication. Refer to the PeerDirect 
Replication Engine (PDRE) documentation for information about replicating data (located in 
the docs directory of the PeerDirect InnerEdge Server installation CD-ROM. 
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